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Introduction  

 Overview 
TJ-YardMate™ is a versatile program created to help you manage your inventory and 
improve your profitability. Designed to meet the demands of a variety of lumberyards, 
TJ-YardMate™ lets you: 

• Establish a database of customers and inventory. 

• Track and store orders by Purchase Order number, Customer and Location. 

• Generate Cut History reports based on product, customer, or date. 

• Prioritize Cut analysis logic based on preferred lengths, maximum waste flexibility and 
blocking panel usage. 

• Track waste by job or by total-per-day, -week, -month or -year. 

• Use flexible formats to print Cut Lists, Shipping Tickets and Customer Reports. 

• Easily import TJ-Xpert® job products into the Order information, filtering them by 
Product Type, Accessories, Job Comments and Member Labels. 

• Utilize network capabilities permitting multiple users to perform different operations at 
the same time. For example: order entry by salesmen, cut analysis by yard foremen, 
and incoming product management by the Purchasing Manager. 

• Track Product/Purchase Orders for status updates and product inclusion in the stock. 

• Update TJ product automatically using TJ-Xpert® product lists. 
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User Environments 
A TJ-YardMate™ user is normally the associate of a Retail Dealer or a Distributor. Retail 
Dealers usually have a customer list consisting of builders while Distributors have a 
customer list consisting, most often, of lumberyards.  

TJ-YardMate™ has the flexibility to meet the different needs of many different types of 
lumberyards: 

• Cutting Yards  
All cuts are made at the yard. This is the yard profile TJ-YardMate™ was developed to 
fully serve. A user is assigned access to each tab (or function) and may want to utilize 
all the available reports.  

• Non-Cutting Yards  
All cuts are made on the job-site. Often these yards stock only a few different lengths 
of each product. Their goal is to find the optimal way to get the Order out of the 
available inventory lengths; any offcuts are considered shipped waste. This user may 
only want to utilize the program for Cut Optimization and Inventory. Cut and 
Inventory history reports may also be useful. 

• Record Keeper  
The Orders match Purchase Order #’s and is maintained by Customer Location.  
All incoming product is tracked via Track Product On Order.  

• Quick Cutter 
Optimizing cuts is the priority of this User Guide. Using AutoNumber and Optimize 
Order capabilities increases the speed with which these orders are optimized. 

TJ-YardMate™ can be setup two different ways: 

• Stand-alone which has the same user entering all the orders, inventory and cut 
analysis.  

• Networked which allows different people to access the program for different needs. 
Many salesmen may enter orders, a Purchasing Manager would work with the 
Inventory and a Yard Foreman would utilize the Cut Optimization capabilities of the 
program. 
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Software License Agreement for TJ-YardMate™ 
 THIS SOFTWARE LICENSE AGREEMENT is made and entered into by Trus Joist, a limited partnership, herein 
known as TJ, and the USER. 

1. TERMS. TJ grants USER, a non-exclusive, non-transferable license to operate the TJ-YardMate™ 
software (software). This software and all related documentation are proprietary and are copyrighted and 
may not be copied, transferred, or incorporated into other products without the prior written consent by an 
officer of TJ. This software is provided in an Executable Code (machine-readable) format only.  Clicking 
Agree in the installation’s Software Terms of Agreement dialog box and proceeding with the TJ-
YardMate™ installation confirms that you have read this Software License Agreement and agree to abide 
by it. The license shall continue in effect until USER returns or destroys all copies of TJ-YardMate™. 

2. USER OBLIGATIONS. USER is obligated to have only trained, competent personnel operating the 
software. USER expressly acknowledges responsibility for accuracy of input and review of all output for 
reasonableness. Use of the software in regard to any other look-a-like products constitutes an illegal use of 
the software.  

3. REGISTRATION. USER is responsible for completing, reviewing, or assisting in completing, and returning 
to TJ, the printed Software Registration Form. The name and address used on the Software Registration 
Form should match that entered when installing the software. The address must be for the location at 
which the software is to be installed and used. The name and address must be kept current for proper 
registration. 

4. LIMITED WARRANTY AND DISCLAIMER. TJ warrants that the media on which the SOFTWARE is 
furnished will be free from defects in materials and workmanship. TJ’s entire liability and your exclusive 
remedy under this warranty (which is subject to returning the SOFTWARE to TJ) will be, at TJ’s option to 
attempt to correct or work around errors, to replace the SOFTWARE or distribute media with functionally 
equivalent software or media, as applicable, or to terminate the Agreement. EXCEPT FOR THE ABOVE 
EXPRESS LIMITED WARRANTEES, TJ MAKES AND YOU RECEIVE NO WARRANTIES, EXPRESS, 
IMPLIED, STATUTORY OR IN LIMITED ANY COMMUNICATION WITH YOU, AND TJ SPECIFICALLY 
DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OF FITNESS FOR A PARTICULAR 
PURPOSE. TJ DOES NOT WARRANT THAT THE OPERATION OF THE PROGRAM WILL BE 
UNINTERRUPTED OR ERROR FREE. If improper functionality is suspected, please contact your local TJ 
Automation Representative or TJ Engineering Automation immediately, at the following address and phone 
number: 

Trus Joist Engineering Automation Group 
7800 East Orchard Road, Suite 200 

Greenwood Village, CO  80111 
(303) 770-8506 

5. LIMITATION OF LIABILITY. NEITHER TJ NOR ANY PERSON INVOLVED IN THE CREATION, 
DEVELOPMENT, PRODUCTION OR INSTALLATION OF THIS SOFTWARE SHALL BE LIABLE FOR 
DAMAGES ARISING FROM SOFTWARE MALFUNCTIONS, HARDWARE EQUIPMENT FAILURES, 
ERROR IN INPUT DATA, ERRONEOUS COMPUTER OUTPUTS RELATIVE TO THE APPLICATION 
REQUIREMENTS OR FOR ANY CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL DAMAGES 
RESULTING FROM USE OF THE SOFTWARE OR ARISING OUT OF ANY BREACH OF WARRANTY, 
EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

6. PERIOD FOR AGREEMENT. USER shall have the right to use the TJ-YardMate™ software as long as it 
is a mutually beneficial arrangement between USER and TJ. TJ retains the ownership of the TJ-
YardMate™ copyright, title and ownership of software and media. TJ retains the ownership of the TJ-
YardMate™ license and the right to revoke this agreement. USER agrees to return the original TJ-
YardMate™ distribution media and related documentation when requested by TJ and to destroy any 
remaining copies of the software program and related documentation, in electronic or any other format. 
 

Please mail the completed and signed form to:  
Trus Joist, Attn: Software Registration, 7800 East Orchard Road, Suite 200, 

Greenwood Village, CO USA 80111. 
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TJ-YardMate™’s Online Help 
The online help for this version of TJ-YardMate™ is designed to open in the HTML Help 
viewer. The Help file opens to a Tri pane HTML Help window containing three tabs: 

 

Tab: What it does: 

Contents Displays books and pages. Click a book and it expands to show groups 
of pages. Click a page to view its corresponding topic. 

Index Provides a list of keywords. Click a keyword to view its corresponding 
topic. If several topics reference the same keyword, select the topic to 
view from a popup menu. 

Search Enter words or phrases to scan topic content and find all topics that 
match the search criteria. 

 
Browse Sequences 

Browse sequences allow users to move forward and backward through a series of topics 
arranged in a specific order. TJ-YardMate™’s Browse Sequences are located above the 
main topic window. By clicking on the Next and Previous buttons, you can step through 
related topics. Clicking on the drop down box located just below these buttons allows you 
to view all available predefined (color-coded sequences in a drop-down list) browse 
sequences. 

 
Context Sensitive Help 

If you want to find information about the current window, click Help in the lower right of 
the window. TJ-YardMate™ opens a Help window containing information on the current 
window. 
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The TJ-YardMate™ Window 

The TJ-YardMate™ program has one main window with three tabs that are used to enter 
Order, Cut Optimization and Inventory information.  

This section describes the main window of TJ-YardMate™ only.  

Information about other dialog boxes and messages is found in the online help. 

Access to individual or all tabs is authorized in the User Security dialog box.  

On the File menu, click User Security to open the User Security dialog box. 
Note:  Users assigned only Orders or Cut Optimization capabilities can view the Inventory tab but 
cannot enter any inventory information changes.  

Orders tab 

 

Figure 1 Orders and Shipping Info tabs 

The Orders tab is used to enter an order or to review a specific order. This tab contains 
three group boxes and two tabs for entering order information.  

March 2005 TJ-YardMate™ 2.10 7 
 



 

Customers group box 
The Customers group box contains a Customers scroll box, Add, Edit, and Delete 
buttons. 
This group box lists the entered customer names. It is used to enter new customers and to 
edit or delete existing customers.   
Select a specific customer to view their entered Locations information.  
Add button  
Click to enter the name of a new customer in the Shipping Info tab's Customer Address 
group box.  
Edit button 
Click to change the name of a selected customer. 
Delete button 
Click to remove a selected customer from the list.  

Locations group box 
The Locations group box contains a Locations scroll box, Add, Edit, and Delete buttons. 
Select a customer name from the Customers list. The available locations for the customer 
are listed in the Location scroll box. 
If the selected customer has more than one location, all entered locations are listed.  
Add button 
Click to enter a new location for a selected customer in the Shipping Info tab's Customer 
Address group box.  
Edit button 
Click to change the name of a selected location. 
Delete button 
Click to remove a selected customer’s location from the list. 

Orders group box    
The Orders group box contains the Orders table, Only Show Open Orders check box, 
Find, Add, Save, Delete, Copy, and Cancel buttons. 
When a customer location is selected, the Orders table lists the available orders for that 
location. The Shipping Info and Order Details tabs are active for the selected order.  

Orders table 
The Orders table contains these columns: 
Order # column  
Order # is the order reference number used to track orders and for the Cut Optimization 
process.  
Status column 
The status of each order is established by the program. It indicates what tasks have or have 
not been completed for the order.  
These labels are only changed when an action is done to the order. A status cannot be 
manually changed. However, some actions may automatically return the status to a 
previous status level.  
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There are three status levels for an order, each status building on the previous status’ 
requirements: 

New 
The order is valid, has an Order # assigned and has been saved. 
Entered  
At least one order item has been included in the new order.  
Deducted from Inventory 
All Completed Cuts have been deducted from inventory. Order Details cannot be 
adjusted in any way, nor can Deduct actions be undone. This status is the equivalent 
of physically cutting the order; it cannot be put back together.  

Ship Date column  
This is the date the order is to be shipped to the customer or the customer’s Will Call date. 
Description column  
Shows the Description text from the Order Details tab. 
TJ-Xpert Job column 
If applicable, shows the TJ-Xpert® job file the order was imported from. 
Created column 
This is the date the order was created. 
Cut column 
This is the date the order was cut. 

Only Show Open Orders check box 
Click to list only open orders in the Orders table. 
The orders listed in the table are restricted by the date in the Order History Cutoff Date 
list box. 

Find button 
Click to open the Find Order dialog box.  
Use the dialog box to locate a specific order. 

Add button    
Click to add a new order for the customer.  
The Order # field becomes active on the Shipping Info tab.  
The Shipping Details and the Order Details tab information can then be completed. 

Save button    
Click to save any new or changed order information.  
Customer, Location, and Order # information must be entered first to save an order. 

Delete button 
Select a specific Order # in the Orders table and click to remove the order from the list. 

Copy button 
Click to copy the selected order information to a new order for the customer.  
The copy becomes the active order. The Order # text box in the Shipping Address group 
box is blank for a new number to be assigned.  
Click Save to add the copied order to the Orders table as a new order line. 
Orders cannot be copied to different customers or locations.  
Cut information cannot be copied. 

Cancel button 
Click to delete all order information, new or edited, that has not been previously saved. 
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Shipping Info tab 

 
Figure 2 Shipping Info tab 

The Shipping Info tab consists of an Order History Cutoff Date list box, a Customer 
Address group box, and a Shipping Address group box. 

The tab is only active if a new customer or location is added or edited, an order is 
selected in the Orders table, or a new order is being created.  

The text boxes are not available unless the Edit or Add buttons in the Customer or 
Location group boxes are selected.  

Order History Cutoff Date list box 
Click the list box arrow to open the Calendar. 
Use the Calendar to select a date to view orders in the Orders table.  
Orders are listed from the selected date to today. 

Customer Address group box  
This group box contains the Street Address, City, State/Province, Country, Zip or 
Postal Code, Phone and Fax text boxes, and Save, Cancel, and Copy buttons. 
The customer’s location address information is entered in these text boxes:  
Street Address, City, State/Province, Country, Zip or Postal Code, Phone and Fax.  
Save button  
Click to save any information in this group box. 
Cancel button 
Click to undo any entries in this group box. 
Copy button 
Click to copy all the information listed in the Customer Address group box to the 
Shipping Address group box. 

Shipping Address group box 
This group box contains an Order # text box, Autonumber check box, Ship Date list box 
or Will Call box, Date and Will Call buttons, and shipping information text boxes for 
Street Address, City, State/Province, Country, Zip or Postal Code, Phone and Fax.  
The Shipping Address group box is for order-specific address information. This is the 
address where the order is to be delivered to.  
Order # text box 
Type a specific order number or click the Autonumber check box. 
An order number is required to save the order.  
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Autonumber check box 
Select to have TJ-YardMate™ automatically assign the next available order number to the 
order. 
Ship Date list box or Will Call box 
Type a date in the field or 
Click the list box arrow to open the Calendar. 
Use the Calendar to select a date to the order is to be shipped. 
If the Will Call button is selected, the list box shows Will Call. 
Date button 
Click to activate the Ship Date list box. 
Will Call button 
Click to change the Ship Date list box to Will Call. 
This is used when the ship date is undetermined. 
This is not a required field for creating new orders. 
Ship To text box 
This text box contains the end customer’s name or the name of the person the order is to be 
sent to. 
 

Order Details tab 

 

Figure 3 Order Details tab 

The Order Details tab contains the Quantity, Length, Product # text boxes, a Product 
box, a Blocking check box, Save Item and Delete Item buttons, an Order Detail table, a 
Description scroll box, a TJ-Xpert Imported Jobs scroll box, Optimize Order and 
Print buttons.  

The Order Details tab is used to enter the actual product information of the order. The 
current Status of the order is also shown. 

The first row of text boxes, buttons and options are used to add and remove products 
from the order. The entered product information is listed in the Order Details table. 

Quantity text box 
Type the number of pieces to order for the specified product.  
Length text box 
Type the product length measurement to be shipped.  
For accessories, such as hangers, or other products that are not cut, skip this text box. 
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Product # text box 
Type the product identification number or SKU#, if known.  
If a number exists in the TJ-YardMate™ database, but you do not know it, TJ-YardMate™ 
will automatically enter the existing number when the product is selected in the Product 
dialog box.  
Product box 
This box shows the selected product in Product # text box or the product chosen from the 
Product dialog box.  
Product selection is available for changes until the order is deducted from inventory. 
Product button 
Click to open the Product dialog box. 
Use the dialog box to select a product.  
Add/Save Item button 
This button is Add when new order details are being added to the Order Details table. 
This button is Save when edits are made to order details in the Order Details table.  
Click Add to add the Product information to the Order Details table.  
Click Save to save changes made to order details in the Order Details table.  
A product is not part of the order until it is added to and saved in the Order Details table. 
Delete Item button 
Click to delete the selected order detail line from the Order Details table. 
Description scroll box 
Use the scroll box to enter order details about the order. 
The Description appears in the Description column of the Orders table. 
TJ-Xpert Imported Jobs scroll box 
Lists the TJ-Xpert® jobs having product included as part of the order. 

Import TJ-Xpert Job button 
Click to open the Import TJ-Xpert Job dialog box. 
Use the dialog box to import TJ-Xpert® job file. 

Optimize Order button 
Click to move the current order’s information to the Cut Optimization tab.  
This button does not initiate Cut Optimization. 
Print button 
Click to open the Print dialog box. 
Use the dialog box to print reports for the order.  
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Cut Optimization tab 

 
Figure 4 Cut Optimization and Order List tabs 

The Cut Optimization tab is used to enter the parameters for cutting the ordered product 
to make the most efficient use of the current inventory.  
This tab shows the order information and order details from the Orders tab.  
It contains the Order List, Remaining Cuts, and Completed Cuts tabs and a Selected 
Orders group box. 

Selected Orders group box 
This group box contains the Selected Orders table, an Add and a Remove button. 

 Selected Orders table 
This table lists the orders that are to be included in the current cut analysis. 
The table is view only. Data in the table cannot be changed directly in the table. 
The columns of this table are: 

Identifier column 
This column lists a program-assigned cut order ID number if multiple orders are cut. 
Example 1:  (O-1) for the first order, (O-2) for the second order.  
Example 2:  If an order contains more than one imported TJ-Xpert® job level, the 
program assigns an ID code to distinguish the levels within the order. A cut order 
containing two product orders, with the second order containing three TJ-Xpert® job 
levels would read: (O-2)(JL-1); (O-2)(JL-2) ; (O-2)(JL-3). 
Order # column 
This column is the order’s reference number that is included in the Cut Optimization.  
Status column 
This column indicates what tasks have and have not been completed for the order. 
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Ship Date column 
Shows the required ship date of the order to the customer. 
Description column 
Shows the text from the Description text box on the Order Details tab. 
TJ-Xpert Job column 
Shows the imported TJ-Xpert® job(s) file name included in the order. 
Created column 
Shows the date the order was created. 

Add button 
Click to open the Select Order dialog box. 
Use the dialog box to select orders to add to the cut analysis. 

Remove button 
Click to delete a selected order from the Selected Orders table. 
 

Order List tab 

 
Figure 5 Order List tab 

This tab lists all products included in the cut analysis.  

The Order List tab contains the Order List table, the Cut List Notes text box, the Copy 
to Shipping Ticket button, the Shipping Ticket Notes text box, the Cut Preferences 
and Cut Optimize buttons. 

Product Information table 
This table lists product details for the products ordered. 
Quantity column 
Shows the number of pieces ordered for each product. 
Length column 
Shows the designated length of each product orders. 
Product # column 
Shows the product ID or SKU number. 
Product column 
Shows the description of the selected product 
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Blocking column 
Shows whether or not the item is to be considered random length. 
Identifier column 
Shows an assigned cut order ID number for the product, if multiple orders are cut. 
Example 1:  (O-1) for the first order, (O-2) for the second order.  
Example 2:  If an order contains more than one imported TJ-Xpert® job level, the program 
assigns an ID code to distinguish the levels within the order. A cut order containing two 
product orders, with the second order containing three TJ-Xpert® job levels would read: 
(O-2)(JL-1); (O-2)(JL-2) ; (O-2)(JL-3). 
Plot Labels column 
Shows the plot label imported from the TJ-Xpert® product. 

Cut List Notes text box 
Type special notes to be included with the Cut List printed report. 

Copy To Shipping Ticket button 
Click to include the Cut List Notes on the Shipping Ticket printed report. 

Shipping Ticket Notes text box 
Type any additional notes to included with the Shipping Ticket printed report. 

Cut Preferences button 
Click to open the Cut Defaults tab in the Defaults dialog box. 
Use the Cut Defaults tab to change the cut defaults. 

Cut Optimize button 
Click to start the cut analysis process.   

Note:  Only pre-defined, cut-type products (TJI® joists, TimberStrand® LSL, Parallam® PSL, Microllam® 
LVL) are sent to cut analysis. Pre-defined, non-cutting products such as hangers, or user-defined 
products such as TimberStrand™ studs can only be deducted from existing inventory.  
 

Remaining Cuts tab 

 

Figure 6 Remaining Cuts tab 

The Remaining Cuts tab is used to create cut patterns either before or after cut analysis. 
All items not optimized during cut analysis are shown on this tab for custom cut patterns. 
The custom cut patterns are manually entered. All cut patterns are included on the 
Completed Cuts tab. 
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The Remaining Cuts tab contains a Current Pattern and a Current Product group 
box. 

Current Pattern group box 
This group box is used to create a cut pattern manually because the Cut analysis could not 
automatically produce it based on the available inventory or Cut Defaults requirements.  
Information in this group box is changed by selections made in the Current Product group 
box. 
Product box 
Shows the product name of the select product in the Product scroll box of the Current 
Product group box. 
The current cut pattern is applied to this product. 
The default product is the first product listed in the Product scroll box.  
Cuts box  
Lists each cut length to be made to create the cut pattern.  
Double-click a product listed in the Length field of the Remaining Cuts table or the 
Remaining Blocking table to include it in the Current Pattern Cut box as Cut 1, Cut 2, 
etc.  
Each time a cut is added to the Current Pattern Cut box, the Length table is updated to 
show the smallest in-stock length that will allow all cuts to be made.  
A maximum of ten cuts can be entered in the Current Pattern Cut box.  
Length box 
Shows the selected Available Inventory length, from the Current Product group box, as 
the pulled length to be applied to the cut pattern. 
OffCut box    
Shows the remaining length based on the Available Inventory length selected and the 
entered cuts that are returned to stock or shipped as waste.  
The Offcut amount is adjusted each time a cut is entered or the Available Inventory 
Length is changed.  
Repeat Cut Pattern spin box  
The program automatically shows the maximum number of times the active cut pattern can 
be repeated to fill the order.  
Click the  buttons to adjust this number up or down based on the versatility of the cut 
pattern.  
Product is returned to the Remaining Cuts table to be cut again. 
Ship Waste check box 
Check this box to indicate a cut without actually making it.  
Example:  A remaining cut of 21’ is made but 23’ is shipped. The customer accepts 2’ of 
waste to avoid making the additional physical cut.  
The OffCut length is shown in red as S. 
Clear Current Pattern button   
Click to completely clear all information from the Current Pattern group box and begin 
entering a new pattern. 
Add to Completed Cuts button    
Click to move the current cut pattern onto the Completed Cuts tab. 
Completed cuts are included in the Cut Report output. 

Current Product group box 
This group box contains all cuts for the order that were not optimized in cut analysis. Use 
the Current Pattern group box to manually create patterns for these product cuts. 
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Product scroll box 
This scroll box shows the products available for manual cut entry.  
The product name is listed for each type of product in the Cut Order.  
When all remaining cuts for the listed item(s) have been completed, the product name is 
removed from the scroll box. 
Remaining Cuts table 
This table contains all remaining cut lengths and quantities for the current product.  
Select a cut length and click Add to Pattern or  
Double-click a Length to add it to the Current Pattern Cut box in the Current Pattern 
group box (Cut 1, Cut 2…).  
Repeat until no product remains in the Product scroll box. 
Remaining Blocking table 
This table contains the amount of blocking that will fit in a cut pattern.  
Click the Blocking text box to enter a specific amount of blocking. Type a length and 
clicking Blocking.  
The Blocking entry cannot exceed the footage listed in the Remaining Blocking table’s 
Length column.  
Available Inventory table    
This table lists all in stock lengths and quantities for the selected product.  
Select a listed length to accommodate the selected cuts.  
The selection is shown in the Length field of the Current Pattern group box.  
The Quantity listing changes based on the amount of product used for the cut pattern. 
Add to Pattern button 
Click to add the selected cut length to the Current Pattern Cut box in the Current 
Pattern group box (Cut 1, Cut 2…).  
Blocking text box 
Type a specific amount of blocking length for the cut pattern. 
 The Blocking entry cannot exceed the footage listed in the Remaining Blocking table’s 
Length column. 
Blocking button 
Click to add the selected blocking length to the cut pattern. 

WARNING!  You cannot return to the Orders or Inventory tabs without losing the 
Completed Cuts entries. This is after Cut Optimization is successful or when Add 
to Completed Cuts on the Remaining Cuts tab is selected. 
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Completed Cuts tab 

 
Figure 7 Completed Cuts tab 

The results of the cut analysis and Remaining Cuts tab entries are shown on the 
Completed Cuts tab.  

Inventory table  
Lists the quantity, length and product to be cut. 
Cuts table  
Lists all cuts to be made by length.  
OffCut table 
Lists the remaining lengths after the cut is completed.  
R designated offcuts are returned to stock.  
A red W designates offcuts as yard waste. 
A red S designates offcuts as shipped waste.  
Waste box 
Shows the waste for the current cut order in total lineal feet and as a percentage of the 
customer order’s total lineal feet. 
Remove Cut button 
Click to remove any selected cut(s) from the pattern 
All selected cut patterns are removed from the completed cuts and lengths are returned to 
the Remaining Cuts tab to be re-cut. 
Print button 
Click to open the Print dialog box. 
Use the dialog box to generate a Cut List or Shipping Ticket. 
Deduct From Inventory button 
Click to accept all listed cut patterns and subtract them from the existing inventory.  
Actual inventories are adjusted and the cuts are added to the cut history.  
TJ-YardMate™ designates this as a physically executed cut. 
The results of this action cannot be reversed automatically.  
The order is placed in a Deducted status.  

The Uncut Items Warning message appears if any product remains to be cut. You 
must create a cut pattern for these items or they will be dropped from the order. Click 
Yes to create a new order or No to eliminate the undelivered products. 
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Inventory tab 

 

Figure 8 Inventory tab 

The Inventory tab is used to manage in-stock inventories, allocate inventories, set re-
order inventory levels, and track in-coming inventories.  

The tab is identified as Inventory (Low) when the inventory quantity of one or more 
products is below the default Order At amount.  
Print the Low Inventory Report to identify these inventory items.  
Inventories reaching zero (0) are shown in the row in red. 

This tab contains two group boxes and one table box, an Only Show Products with 
Inventory check box, a Track Product On Order and Print Inventories buttons.  

Product Groups group box 
This group box lists all available product groups or types.  
Product groups are added, edited, or deleted in this group box. 

 Product Groups scroll box 
Lists all available product groups. 
If Only Show Products with Inventory is checked, only those product groups with 
inventory are listed in the scroll box. 
Add button 
Click to add a product group to the Product Groups scroll box.  
Edit button 
Click to edit a user-created group name.  
TJ-YardMate™ defined product group names cannot be edited. 
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Delete button 
Click to remove the selected user-defined product group. 
TJ-YardMate™ defined product groups cannot be deleted.  
All products and their inventories within the group are permanently removed. 

Products group box 
This group box lists the products associated with the selected Product Group. 
Select a specific product to work with in the Inventories table.  
Product Groups scroll box 
Lists all available products for the selected Product Group. 
If Only Show Products with Inventory is checked, only products with inventory are listed 
in the scroll box. 
Add button 
Click to add a product to the Products scroll box.  
Edit button 
Click to edit a user-created product name.  
TJ-YardMate™ defined products cannot be edited. 
Delete button 
Click to remove the selected user-defined product. 
TJ-YardMate™ defined products cannot be deleted.  
All products and their inventories are permanently removed. 

Inventories table 
This table is used to view details about, and to add, edit, and delete specific products in the 
inventory.  
All columns except Available and On Order can be changed.  
Double-click any cell in the Inventories table to view the total lineal footages for the 
selected product. 

Length or Description column 
If the product is a TJ product, this column is Length.  
If the product is a non-TJ product, this column is Description.  
Available column 
This is the inventory available for cut orders.  
This quantity is the In-Stock quantity minus the Allocated quantity.  
In Stock column 
This is the total physical inventory on hand. 
Allocated column 
This is the amount of the physical inventory that is designated to specific orders. 
Order At column 
This is the user defined re-order quantity amount.  
On Order column 
This is the quantity of product that is on order but not yet received. 
Hint:  Inventory totals can be changed in the In Stock, Allocated, or Order At cells.  
Select the cell and press either the + (Plus) key to add inventory or the – (Minus) key to subtract. The 
Add/Subtract dialog box opens. Use the dialog box to make the inventory adjustments.  
You can also click in the cell and directly type the new number. 

Add button 
Click to add a new row to the Inventories table. 
Use the new row to add a user-defined inventory item. 
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Edit button 
Click to edit a user-defined product’s description. 
TJ-YardMate™ product descriptions cannot be edited.  
Delete button 
Click to delete a selected product from the Inventories table. 
Only user-defined inventory items can be deleted. 
TJ-YardMate™ items cannot be deleted.  
All products and their inventories within the group are removed permanently. 

Hint:  Use the arrow keys to navigate the various columns and fields. 

Only Show Products With Inventory check box 
Select this check box to only view product and product groups with inventories over zero. 
This is recommended after the initial inventory entry.  

Track Product On Order button 
Click to open the Products on Order dialog box. 
Use the dialog box to create and track incoming inventory. 

Hint:  If this button is not visible, go to the Tools menu and select Defaults. 
The Defaults dialog box opens. 
Click the Inventory Defaults tab and select the Track Products On Order checkbox. 

Print Inventories button 
Click to open the Inventory Report dialog box. 
Use the dialog box to print Current Inventory or Low Inventory reports. 
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TJ-YardMate™ Setup 

Adding New Users 
1. Open TJ-YardMate™. 
2. Login as a DefaultUser with no password. 
3. On the File menu, click User Security. 

The User Security dialog box opens. 
4. Click Add. 

The Add New User dialog box opens. 
5. In the Add New User text box, type the user’s login name. 
6. Type the First Name and Last Name of the user in the designated text boxes. 
7. In the Password text box, type a password. 
8. In the Confirm text box, re-type the password, exactly the same as the first entered password.  
9. Click OK.  

The Add New User dialog box closes. 
The User Security dialog box returns. 

10. Click the Current User list box arrow and select the just entered user name from the list. 
11. In the Access Permission group box, select all applicable check boxes to grant the user access 

rights to the different areas of TJ-YardMate™. 
Access Permissions 
Administer grants user access to User Security. 
Order grants the user access to the Orders tab of the program.  
Cut Optimization grants user access to the Cut Optimization tab of the program.  
Inventory Management grants user access to make changes to the inventory and Track Products On 
Order. 

Note: All users can view the inventory even if they do not have the authorization to Inventory.  

12. Click OK. 
The User Security dialog box closes. 

13. On the File menu, click Exit. 
14. Restart TJ-YardMate™. 
15. Have the new user log-in using their login name and password. 
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Setting Program Defaults  
Setting Cut Defaults 
1. Open TJ-YardMate™. 
2. On the Tools menu, click Defaults. 

The Defaults dialog box opens. 
The Cut Defaults tab is active. 

3. Verify the Show Products with Inventories Only check box is selected. 
A selected box limits the visible list of available inventory items. 

Note: Normally the Show Products with Inventories Only check box is not selected until all inventory 
is entered.   

4. Review the Product Groups table. 
The table lists product by type. 

5. Select the Maximum Waste text box next to the first product listed in the table, and type the 
maximum number of length to waste. 
Maximum Waste is the longest piece of material to allow the cut analysis to waste when it 
selects this product. 

6. Repeat Step 5 for all products listed in the table. 
7. Select the Saw Kerf text box next to the first product listed in the table, and type the width of 

the saw blade. 
Saw Kerf is the width of the saw blade. 

8. Repeat Step 7 for all products listed in the table. 
9. In the Blocking Defaults group box: 

Type the Minimum Cut value. This value prevents using Offcut lengths for blocking if they 
are equal to or less than the displayed value. 
Type the Maximum Cut value. This value prevents using Offcut lengths for blocking if they 
are equal to or more than this value. 
The values in the text boxes are blocking lengths added to the ordered lengths for cut analysis. 

10. In the Cut Preferences scroll box, select the check box next to the applicable preference. 
11. Click the up or down arrows on the right to change the priority a preference has in the cut 

analysis. 
The preference listed first is considered most important. 

12. Click Apply to save the changes made in the Cut Defaults tab as the default selections.  
13. Click OK to save the all changes made and to close the Defaults dialog box.  
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Setting Inventory Defaults 
Select the Inventory Defaults tab to change inventory controls for a specific product.  

1. Open TJ-YardMate™. 
2. On the Tools menu, click Defaults. 

The Defaults dialog box opens. 
The Cut Defaults tab is active. 

3. Click the Inventory Defaults tab. 
4. In the Product Groups table, click the first product group listed in the table. 

Available individual joist items are listed in the Products table. 
5. For the first product listed in the table, place the cursor in the Product # text box. 
6. If applicable, type a product ID or SKU number. 
7. Press TAB to move the cursor to the Increment column. 
8. Type the value to round down to by the nearest increment value.  

For example, if the increment value is 2’ and the offcut length is 23’, the length returned to 
stock is listed as 22’. 

9. Press TAB to move the cursor to the Bundle column. 
10. Type the number of pieces in a bundle for the selected product. 

The pieces in a bundle are determined by the supplier. 
11. Repeat Steps 5-10 for all product groups and products in the table. 
12. If applicable, select the Use Fixed Inventory Only check box. 
13. If applicable, select the Track Products On Order check box. 
14. Click Apply to save the changes made in the Inventory Defaults tab as the default selections. 
15. Click OK to save the all changes made and to close the Defaults dialog box.  
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Setting Preferred Lengths 

Select the Preferred Lengths tab to define the ten most frequently cut lengths, if known, 
so that they are returned to stock as often as possible. 
1. Open TJ-YardMate™. 
2. On the Tools menu, click Defaults. 

The Defaults dialog box opens. 
The Cut Defaults tab is active. 

3. Click the Preferred Lengths tab. 
4. In the Product Groups scroll box, select a product group.  
5. In the Product scroll box, select a product. 
6. In the Lengths table, enter the most popular length in Rank 1. 
7. Continue entering a maximum of nine more lengths in descending order of preference. 
8. Repeat Steps 4-7 for all product groups and products. 
9. Click Apply to save the changes made in the Preferred Lengths tab as the default selections. 
10. Click OK to save the all changes made and to close the Defaults dialog box. 

 
Setting Program Defaults 
Select the Program Defaults tab to select the program locations and length measurement 
units. 

1. Open TJ-YardMate™. 
2. On the Tools menu, click Defaults. 

The Defaults dialog box opens. 
The Cut Defaults tab is active. 

3. Click the Program Defaults tab. 
4. In the Program Paths group box, select the file locations for the Database and the TJ-

Xpert® jobs for importing. 
The default Database location is: C:\Program Files\Trus Joist\TJ-YardMate\Program 
The default TJ-Xpert® location is: C:\Program Files\Trus Joist\TJ-Xpert\Jobs 

5. In the Length Display group box, select the unit of measure that TJ-YardMate™ is to use 
when displaying measurements. 

6. Click Apply to save the changes made in the Program Defaults tab as the default selections. 
7. Click OK to save the all changes made and to close the Defaults dialog box.  
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Building or Adding Inventory 
1. Open TJ-YardMate™. 
2. Click the Inventory tab. 
3. In the Product Groups scroll box, select a product group. 
4. In the Products scroll box, select a product to review or build its inventory. 
5. In the Inventories table, click Add. 

A new line is added to the Inventories table. 
Note:  The first column of the table is entitled either Length for a TJ product or Description for a 
non-TJ product. 

6. Place the cursor in the In Stock column. 
7. Type the physical inventory count of the product. 

Note:  In the In Stock, Allocated, and Order At columns:  
Press the +(PLUS) key to use the Add dialog box or  
Press the – (MINUS) key to use the Subtract dialog box. 

8. Press TAB to move the cursor to the Allocated column. 
9. Type the value of the Allocated inventory for the product. 
10. Press TAB to move the cursor to the Order At column. 
11. Type the value when the product must be re-ordered. 
12. Repeat Steps 3-11 for all product groups and products. 
13. Click Print Inventories. 

The Inventory Report dialog box opens. 
Use the dialog box to print the Inventory report.  
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Entering Ordered Products 
Ordered products are entered in the Product On Order dialog box.  

This dialog box is used to enter and track purchase orders for multiple products, delete 
purchase orders, receive entire or partial orders, and print the orders. 

All entered products are shown in the On Order column for each Length listed in the 
Inventories table. Purchase order entry affects only the Inventories table information. 

1. Open TJ-YardMate™. 
2. Click the Inventory tab. 
3. Click Track Product On Order. 

The Product On Order dialog box opens.  
Note:  Select the Only Show Open Product Orders check box to filter the orders list. 
Click the PO Cutoff Date list box arrow and select a date to limit the orders in the table to those after the 
selected date. 

4. In the Product Order Info group box, click Add. 
The cursor moves to the Purchase Order # text box. 

5. Type the Purchase Order number. 
6. Press TAB to move the cursor to the Vendor list box. 
7. Click the Vendor list box arrow and select a vendor or 

Type the name of the vendor in the box. The name is added to the list. 
8. Press TAB to move the cursor to the Contact list box. 
9. Click the Contact list box arrow and select a contact or 

Type the name of the contact in the box. The name is added to the list. 
10. Press TAB to move the cursor to the Date Ordered list box. 
11. Type the date the order was placed or 

Click the list box arrow to use the Calendar to select a date. 
12. Press TAB to move the cursor to the Date Expected list box. 
13. Type the date the order is expected or 

Click the list box arrow to use the Calendar to select a date. 
14. Click Save. 

The order is added to the Purchase Order # table. 
15. In the Product Order Details group box, type the Quantity ordered. 

A minimum Quantity of 1 must be entered. 
16. If applicable, select the Bundles check box. 
17. Press TAB to move the cursor to the Length text box. 
18. Type the Length of the product ordered or 

Click the   button to open the Product dialog box. 
Use the dialog box to select the ordered TJ or non-TJ product(s). 

19. Click Add. 
The product is added to the Product Order Details table. 

20. Repeat Steps 15-19 to add products to the order. 
21. In the Product Order Details table, select a product row. 
22. In the Product Order Details group box, click Save to save the order while entering the 

order. 
If the Product On Order dialog box is closed, all products entered but not saved must be re-
entered. 
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Building Your Customer List 
1. Open TJ-YardMate™. 
2. Click the Orders tab. 
3. In the Customers group box, click Add. 

The cursor is in the Shipping Info tab, Customer text box. 
4. Type the customer’s name.  
5. Click Save. 
6. In the Locations group box, click Add. 

The cursor is in the Shipping Info tab, Location text box. 
7. Type the Location name and any other applicable contact information in the designated text 

boxes.  
8. Click Save. 
9. Repeat Steps 3-8 for each customer. 

Note:  If you do not want to use TJ-YardMate™ for tracking orders, create a dummy customer and 
location to use for all cut orders. 
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Order and Cut Lists Management 

Orders 
Entering an Order 
1. Open TJ-YardMate™. 
2. Click the Orders tab. 
3. In the Customer scroll box, select the desired customer. 
4. In the Location scroll box, select the desired customer location.  

The contact information is shown in the Shipping Info tab’s Customer Address group box. 
5. In the Orders group box, click Add. 

The cursor is in the Shipping Information tab, the Order # text box. 
6. Type the order number in the Order # text box or 

Select the Autonumber check box to have TJ-YardMate™ assign a number to the order. 
Note:  Steps 1-6 is the minimum information required for saving an order. 

7. Type the Ship Date or 
Click the Ship Date list box arrow and use the Calendar to select a date or  
Click Will Call if the date is unknown. 

8. Type the Ship To identifier or contact name. 
This could also be a project name. 

9. Enter the delivery address in the appropriate text boxes. 
10. In the Orders group box, click Save. 

The order listing appears in the Orders table.  
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Importing Product from TJ-Xpert® Jobs 
1. Open TJ-YardMate™. 
2. Click the Orders tab. 
3. In the Customer scroll box, select the desired customer. 
4. In the Location scroll box, select the desired customer location.  

The contact information is shown in the Shipping Info tab’s Customer Address group box. 
5. In the Orders table, click an order row. 
6. Click the Order Details tab. 
7. In the Imported TJ-Xpert Jobs group box, click Import TJ-Xpert Job. 

The Import TJ-Xpert Job dialog box opens. 
8. Use the Directories and Job scroll boxes to locate the JOB file to import. 
9. In the Job scroll box, select the applicable job. 
10. In the Levels scroll box, select the identified building levels to import product information 

from. 
All levels are selected by default. 

11. If applicable, click Change Selected Products. 
The Select Imported Products dialog box opens. 
Use the dialog box to filter the imported product information. 

12. Select the appropriate radio button to Import Blocking As either a Total Length or as 
Separate Pieces. 

13. Click OK. 
The file is imported into TJ-YardMate™. 
The Import TJ-Xpert Job dialog box returns. 
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Receiving an Entire Order 
1. Open TJ-YardMate™. 
2. Click the Inventory tab. 
3. Click Track Product On Order. 

The Product On Order dialog box opens.  
4. In the Receive Order group box, select the Entire Order radio button. 
5. Click Receive Order.  

An order receive confirmation message appears. 
6. Click Yes to receive the order. 
The received order is accepted into inventory and is removed from the Purchase Order 
Info table. 

All On Order values are added to their respective In Stock column in the Inventory 
table. Received values cannot be edited. 

 

Receiving a Partial Order 
1. Open TJ-YardMate™. 
2. Click the Inventory tab. 
3. Click Track Product On Order. 

The Product On Order dialog box opens.  
4. In the Receive Order group box, select the Partial Order radio button. 

The first product row in the Product Order Details table is selected. 
5.  Type the Quantity of the product that has been received.  
6. Click Receive Order. 

An order receive confirmation message appears. 
7. Click Yes to receive the order. 

A new order message appears. 
8. Click Yes to create a new order for the remaining items or 

Click No to cancel the outstanding order.  
The original order is accepted into inventory and is removed from the Purchase Order Info 
table. 
If Yes is selected, the remaining part of the order is entered in the Product Order Details table. 
The cursor is in the Purchase Order # text box. 

9. Type the Purchase Order number. 
For example, Purchase Order # 369’s remaining items can be put on Purchase Order # 369B. 

10. Change the Date Ordered and Date Expected list box information. 
The dates should be changed to the new order and expected received dates. 

11. In the Product Order Info group box, click Save.  
The order is saved in the Product Order Info table. 

12. Click OK to close the dialog box. 
Note:  If product remains to be cut for an order the Uncut Items Warning message appears. The 
message explains that the displayed items will be removed from the order if they are not manually cut. 
Click Cancel to return to the Remaining Cuts tab or click Print to print this list for future reference. Click 
Save To File to make a text file of this information.  
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Cuts 
Cut Optimizing the Order 

Note:  If you do not want to use TJ-YardMate™ for tracking orders, create a dummy customer and location 
to use for all cut optimization orders.  

1. Open TJ-YardMate™. 
2. Click the Orders tab. 
3. In the Customer scroll box, select the desired customer. 
4. In the Location scroll box, select the desired customer location.  

The contact information is shown in the Shipping Info tab’s Customer Address group box. 
5. In the Orders table, select an order row. 
6. Click the Cut Optimization tab.  
7. If applicable, in the Selected Orders group box, click Add. 

The Select Order dialog box opens. 
Use the dialog box to add more orders to the Selected Orders table.  

Note:  This is to include additional orders. 

8. If applicable, enter Cut List Notes in the text box. 
Click Copy To Shipping Ticket to copy the notes to the Shipping Ticket Notes text box. 

9. If applicable, enter Shipping Ticket Notes in the text box. 
10. If applicable, click Cut Preferences to review or change the Cut Default settings.  
11. Click Cut Optimize to initiate the cut analysis. 

Note:  If there is not enough inventory to complete the Cut Optimize process, a warning message 
appears.  Click Yes to continue with the cut optimization process or click No to stop the process. 
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Manually Creating Cuts 
1. Complete the Cut Optimization process for a selected order. 
2. Click the Remaining Cuts tab. 

This tab lists the products not optimized in the cut analysis and is used to manually create a 
cut pattern for these products. 
The Current Product group box lists all product that was not cut during cut analysis.  

3. In the Products scroll box, select one of the listed products. 
 In the Remaining Cuts table, the needed Length and Quantity for the product is listed.  

4. Double-click the desired Length to include in the cut pattern. 
The Length is shown in the Cut 1 box.  

5. Repeat Step 4 for the Remaining Cuts Lengths. 
A maximum of 10 cuts are allowed in the pattern. 

6. When cuts are completed for the product, click Add to Completed Cuts. 
The manual cut process is completed for the product.  
The product is added to the Completed Cuts tab. 
 

If appropriate, use the OffCut length by including Remaining Blocking lengths. 
7. Double-click a Length listing in the Remaining Blocking table or  

Create a specific cut pattern for this material.  
8. If applicable, in the Blocking text box, type a specific length amount for blocking as part of 

the pattern.  
9. Click Blocking. 

The entered Blocking amount is added to Cut 1. 
10. If applicable, repeat Steps 7-9 for all Remaining Blocking material. 

A maximum of 10 cuts are allowed in the pattern. 
11. When blocking cuts are completed for the product, click Add to Completed Cuts. 

The manual cut process is completed for the product.  
The product is added to the Completed Cuts tab. 
 

As product is selected, the program enters the best length, from the Available Inventories table.  
The selection for the pattern is listed in the Current Pattern group box’s Length box.  
12. To change this entry, double-click the Length item you desire to use for the cut.  

The OffCut length is shown in the next box.  
13. The Repeat Cut Pattern spin box shows the number of times this pattern is repeated to fill 

the order.  
Click the  spin buttons to increase or decrease this number.  
The only way to return product to the Remaining Cuts table is by clicking the down button. 

14. Select the Ship Waste check box if the OffCut is sent with the shipped product. 
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Completing Cuts 
1. Complete the Cut Optimization or Manual cut process for a selected order. 
2. Click the Completed Cuts tab. 

The tab lists both the optimization cuts and manually entered cuts.  
Waste is displayed in the lower left corner in lineal feet with a percentage of material used. 

3. To return a product to the Remaining Cuts tab for re-cutting, select a cut and click Remove. 
4. Click Deduct From Inventory. 

The product used for this cut order is removed from the inventory. 

WARNING ! Deduct From Inventory is equivalent to physically cutting materials.  

It cannot be un-done!   

To make an adjustment after this action, Inventory quantities must be changed 
manually and the order (s) must be copied to restore them to an Entered status. 

 

 

March 2005 TJ-YardMate™ 2.10 34 



 

Printing Reports  

Printing a Cut Report or Shipping Ticket 
The information available for this report is based upon the status of the job. The program 
selects groups of information as they become available. 

The Cut List prints the results of cut analysis as displayed on the Completed Cuts tab. 
1. On the Completed Cuts tab, click Print. 

The Print dialog box opens.  
2. If applicable, select the Include TJ-Xpert Labels check box when the order includes 

imported TJ-Xpert® job products.  
3. If the Cut Order has not been deducted from inventory select this report. 

The report is designated as Preliminary.  
If the Cut Order has been deducted from inventory, the Cut List check box is selected to 
include the information for the Order #’s included in cut analysis.  
If product has been deducted from inventory, the Shipping Ticket information is available. 

4. In the Additional Report Notes, type any special information to included on the report. 
5.  In the Shipping Ticket group box, select either Cut In Yard or Cut on Job Site, as 

appropriate.  
6. In the Style group box, click Horizontal. 

This is the layout orientation of the report.  
7. Click Print Preview to view the report before sending it to the printer.  

Click  to exit this window. 
8. Click Print to send the report to the printer. 
9. Click Close to close the Print dialog box. 

Printing the Inventory Report 
1. On the Inventory tab, click Print. 

The Inventory Report dialog box opens. 
2. Select the type of report to print.  

Current Inventory prints a listing of all products currently included in the inventory.  
Low Inventory prints only products with quantities falling at or below their default Order At 
value. 

3. Select the applicable date filter for the report. 
For both the Current Inventory and Low Inventory group boxes, the Include Only 
Changed Inventories Starting Calendar box is available. 
Select this option to print only inventories that have been changed on or after the date entered 
in the Calendar box. 

4. Click Print Preview to view the report before sending it to the printer.  
Click  to exit this window. 

5. Click Print to send the report to the printer. 
6. Click Close to close the Inventory Report dialog box. 
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Printing a Purchase History Report 
1. On the Reports menu, click History then select Purchase. 

The Purchase History dialog box opens.  
This dialog box is used to print a report of purchases based on products, vendors or time 
period. 

2. In the Time Period group box, click the Calendar list box arrows to specify the Starting 
Date and Ending Date for the report.  
For a weekly history enter the week’s beginning and ending dates.  

3. In the Accumulate group box, select a time frame for the report: 
Monthly, Quarterly, or Annually. 

4. In the Products group box, click either the All or Selected radio button. 
Select All to include all products in inventory at the time designated. 
Click Selected to choose specific products for the report. 

Click Change Selected Products to open the Select Groups, Products, and Lengths 
dialog box. 
Use the dialog box to designate specific products for the report. 

5. Select the Include Vendors check box to include vendors in the report.  
6. In the Sort Report By group box, click either: 

The Vendor radio button to filter the report by vendor information first or 
The Time Period radio button to filter the report by the time information first. 

7. Click Print Preview to view the report before sending it to the printer.  
Click  to exit this window. 

8. Click Print to send the report to the printer. 
9. Click Close to close the Purchase History dialog box. 
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Printing a Cut History Report 
1. On the Reports menu, click History then select Cuts. 

The Cut History dialog box opens.  
Use the dialog box to print a report of cuts used by TJ-YardMate™, based on a specified time 
period, for selected or all products and customers. 

2. In the Time Period group box, click the Calendar list box arrows to specify the Starting 
Date and Ending Date for the report.  
For a weekly history enter the week’s beginning and ending dates.  

3. In the Accumulate group box, select a time frame for the report: 
Monthly, Quarterly, or Annually. 

4. In the Products group box, click either the All or Selected radio button. 
Select All to include all products in inventory at the time designated. 
Click Selected to choose specific products for the report. 

Click Change Selected Products to open the Select Groups, Products, and Lengths 
dialog box. 
Use the dialog box to designate specific products for the report. 

5. In the Sort Cuts by group box, click either the Length or Quantity radio button. 
The cuts are listed in the report by the selected option. 

6. Select the Include Customers check box to have customer information part of the report. 
7. In the Customers group box, click either the All or Selected radio button. 

Select All to include all customers at the time designated. 
Click Selected to choose specific customers for the report. 

Click Change Selected Customers to open the Select Customers and Locations dialog 
box. 
Use the dialog box to include only specific customers in the report. 

8. In the Sort Report By group box, click either: 
The Customer radio button to filter the report by customer name and location first or 
The Time Period radio button to filter the report by the date the order was cut optimized first. 

9. Click Print Preview to view the report before sending it to the printer.  
Click  to exit this window. 

10. Click Print to send the report to the printer. 
11. Click Close to close the Cut History dialog box. 
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Printing the Waste History Report 
1. On the Reports menu, click History then select Waste. 

The Waste History dialog box opens.  
Use the dialog box to print a report of waste amounts as lineal footage and as a percent of 
product specified for a given time period.  

2. In the Time Period group box, click the Calendar list box arrows to specify the Starting 
Date and Ending Date for the report.  
For a weekly history enter the week’s beginning and ending dates. 

3. In the Accumulate group box, select a time frame for the report: 
Daily, Monthly, Quarterly, or Annually. 

4. In the Products group box, click either the All or Selected radio button. 
Select All to include all designated waste products at the time designated. 
Click Selected to choose specific products for the report. 

Click Change Selected Products to open the Select Groups or Products dialog box. 
Use the dialog box to designate specific products for the report.  

5. Click Print Preview to view the report before sending it to the printer.  
Click  to exit this window. 

6. Click Print to send the report to the printer. 
7. Click Close to close the Waste History dialog box. 
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Database Management 

TJ-YardMate™ uses an on-demand database backup and compaction utility for database 
management. 

Backup and Compact DB rules 
• The person designated to backup and compact the database must have 

administration rights to TJ-YardMate™. 

• The database does not compact if there is someone accessing it. 

• Once the compact process has started, no one can access the database. 

• A reminder message is shown in the TJ-YardMate™ login screen if the database 
has not been backed up or compacted for 30 days or more. 

Backup and Compact the Database 
1. Click the Windows® Start menu. 
2. Click the Programs  Trus Joist™  TJ-YardMate  Backup and Compact DB menu 

selections as shown below: 

 
Figure 9 TJ-YardMate™ Backup and Compact DB menu selections 
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The Backup and Compact DB sign on dialog box opens. 

 
Figure 10 Backup and Compact DB sign on dialog box  

3. Type your User Name. 
4. Press TAB to the Password text box. 
5. Type your Password and click OK. 

The TJ-YardMate Archive dialog box opens, similar to this: 

 
Figure 11 TJ-YardMate Archive dialog box  

6. Locate and select the designated backup location for TJ-YardMate™. 
7. Click OK. 

The backup and compact process starts. 
When it’s complete, a message appears: 

 
Figure 12 Archive Successful message 
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8. Click OK to close the message. 

When the Backup and Compact DB process is activated again, the previously completed 
backup files are shown in the designated archive folder, similar to this: 

 
Figure 13 Previous completed archives 

Note:  Each archive process creates a new file with a unique date and time name. 
Old archives are not overwritten or deleted. 
If your database is large, it is possible the older archive files will need to be stored on a network drive, 
copied to a CD, or deleted to make room for the most current files. 
Please see your system administrator on where to store the older files. 

.  
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Archiving Messages 
30-day Archive Reminder 

A reminder message is shown in the TJ-YardMate™ login screen if the database has not 
been archived for 30 days or more, as shown below: 

 
Figure 14 30-day Archive Reminder message 

 
Active computer in the database 

If there is an active computer or user using the database, this message appears: 

 
Figure 15 Active Computer in the database message 

Click OK to continue the archive process. 
The database is archived but not compacted. 

Click Cancel to close the message and stop the archive process. 
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TJ-YardMate™ Tutorial 
This tutorial is composed of 16 sections. It takes approximately 1 hour to complete. The 
purpose of the tutorial is to give you a basic understanding of TJ-YardMate™ 
procedures.  

Please follow all the tutorial steps exactly.  

Make changes only when you are specifically instructed to do so.  

To save time and ensure the tutorial results are the same for everyone, you are instructed 
to switch from the software’s Program database to the Tutorial database (Section II). 
This also protects the data integrity of the Program database.  

After completing the tutorial and switching back to the Program database (Section XVI) 
you can change default settings to reflect your company’s needs. Use the online Help for 
more information and procedures. 

Network Users:   One Tutorial database is available for each computer station. 

I. Logging into TJ-YardMate™ 
1. Click the Windows® Start menu. 
2. Click the Programs  Trus Joist  TJ-YardMate  TJ-YardMate menu options. 

The TJ-YardMate™ Login dialog box opens. 
3. Verify that the User Name text box has DefaultUser in it. 

This is the administrator’s User Name. 
4. Verify the Password text box is blank. 

A blank field is the administrator’s password. 
5. Click OK to open the program. 
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II. Switching to the Tutorial Database 

1. On the Tools menu, click Defaults. 
The Defaults dialog box opens. 

2. Click the Program Defaults tab. 
In the Program Paths group box, the Database: field shows the database location the TJ-YardMate™ 
program is currently using.  
The installation default location is: 
C:\Program Files\Trus Joist\TJ-YardMate\ Program\. 

3. Network users – follow these procedures 
a) Highlight all the text in the Database: text box. 

b) On the line below, write the current database location as shown in the Database: text 
box: 
______________________________________________________________ 

c) Click Browse. 
d) Locate the Tutorial folder on your hard drive.  

In a standard installation, this file is located at: 
C:\Program Files\Trus Joist\TJ-YardMate\Tutorial 

e) Double-click the TJ-YardMate.mdb file.  
The Database: text box now shows: 
C:\Program Files\ Trus Joist\TJ-YardMate\Tutorial. 

Stand-alone Users – follow these procedures 
a) Click in the Database: text box and highlight Program\. 
b) Type TUTORIAL\.  

If you used the installation default location, the Database: text box now shows 
C:\Program Files\ Trus Joist\TJ-YardMate\Tutorial\. 

  Note:  If TJ-Xpert® is not installed, change the Program Paths – Import text box to C:\ 

4. Click Apply. 
The work done in the tutorial will now use the Tutorial database.  
A Restart message appears requesting you to restart the program so changes are 
applied. 

5. Click OK to acknowledge the message. 
6. Click OK to close the Defaults dialog box. 
7. On the File menu, click Exit.  

The TJ-YardMate™ program closes. 
8. Restart TJ-YardMate and click OK on the login screen.  
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III. Getting Started 
1. On the File menu, click User Security. 

The User Security dialog box opens.  
2. Click Add. 

The Add New User dialog box opens.  
3. In the Add New User text box, type your desired login name. 
4. Type your First Name and Last Name in the designated text boxes.  
5. In the Password text box, type a password. 
6. In the Confirm text box, re-type the password, exactly the same as the first entered password. 
7. Click OK. 

The Add New User dialog box closes. 
The User Security dialog box returns. 

8. Click the Current User list box arrow and select your name from the list. 
9. In the Access Permission group box, select all check boxes to grant yourself rights to all 

listed areas of TJ-YardMate™.  
10. Click OK. 

The User Security dialog box closes. 
11. On the File menu, click Exit. 
12. Restart TJ-YardMate™. 
13. Login using the new login name and password. 
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IV. Setting Cut Defaults  
1. On the Tools menu, click Defaults. 

The Defaults dialog box opens. 
The Cut Defaults tab is active. 

2. Verify the Show Products with Inventories Only check box is checked. 
A selected box limits the lists of inventory items to product with physical inventory. 

Note: Normally the Show Products with Inventories Only check box is not selected until all inventory 
is entered.   

3. Review the Product Groups table. 
The table lists product by type.  

4. Select the Maximum Waste text box next to TJI®/Pro™ Joists. 
Maximum Waste is the longest piece of material to allow the cut analysis to waste when it 
selects product.  

5. Type 2 in the text box. 
2 designates a maximum of 2 feet of waste material. 

6. Repeat Steps 4-5 for Parallam® PSL and TimberStrand® LSL.  
7. Verify the Saw Kerf text box is 0 (zero) for all products. 

Saw Kerf is the width of the saw blade. 
No changes are made in the Blocking Defaults group box for the purposes of the tutorial. 
The selections made in this group box allow blocking lengths to be added onto order item lengths for cut 
analysis.  
The numbers shown in the text boxes are the defaults. 

No changes are made in the Cut Preferences scroll box. 
The scroll box lists the cut influences selected specifically for this tutorial.  
The priority of each preference during cut analysis is based on its placement in the listing, top placement 
being the most important influence.  

8. Click Apply to save the changes made in the Cut Defaults tab as the default selections. 
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V. Setting Inventory Defaults  
1. Click the Inventory Defaults tab. 

Hint: Use the ARROW keys to move through the Products table. 
2. In the Product Groups table, click TJI®/Pro™ Joists. 

Available individual joist items are listed in the Products table. 
3. Select the 11 7/8” TJI 110 joist. 
4. Move the cursor to the Product # text box and type 1188110. 

This number is used as a reference number (or SKU#).  
5. Press TAB to save the entry in this field.  

No changes are made in the Increment and Bundle text boxes for the purposes of the tutorial. 
The Increment default is 1' and the number of lengths per Bundle is set to reflect current Trus Joist 
bundle counts.  

Note:  All lengths returned to stock are rounded down by their nearest Increment value. For example, if 
the Increment is 2' and a 23' length is offcut, the length returned to stock is listed as 22 '. 

6. Click Apply to save the changes made in the Inventory Defaults tab as the default settings. 
 
VI. Setting Preferred Lengths  
1. Click the Preferred Lengths tab. 

Note:  The information entered in this tab identifies ten of the most commonly sold lengths. These 
lengths are determined by demand and/or history and are returned to stock as often as possible when 
the cut preference Return Preferred Length Offcuts to Stock is selected on the Cut Defaults tab. 

2. In the Product Groups table, click TimberStrand® LSL. 
3. In the Products table, click the 1 ¾” X 11 7/8” 1.7E TimberStrand LSL. 
4. In the Lengths table, type 14 as the length for Rank 1. 
5. Type 16 as the length for Rank 2.  

Hint:  Use the down arrow key to move between fields. 

6. Click Apply save the changes made in the Preferred Lengths tab as the default settings. 
7. Click OK to close the dialog box. 
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VII. Building Your Inventory 
1. In the TJ-YardMate™ window, click the Inventory tab. 
2. Select the Only Show Products with Inventory check box. 

This limits the visible products in the table 
3. In the Product Groups scroll box, click TJI®/Pro™ Joists. 
4. In the Products scroll box, click the 11 7/8” TJI 110 joist.  

Note:  In the Inventories table, the Available, In Stock, and Allocated lengths are shown for the 
selected product 
Available stock is calculated by subtracting Allocated from In Stock.  
Allocated stock is set aside for a specific job and is not available for Cut analysis. 

Hint: Use the + (PLUS) or – (MINUS) keys to add or subtract inventory.  
Use the arrow keys to move between fields. 

5. In the Inventories group box, click Add. 
A new inventory line is added to the table. 

6. In the Length column, type 36.  
7. Press TAB to save the entered data.  
8. In the In Stock field, type 43 as the current number of pieces in the yard.  
9. In the Order At field, press the + key.  

The Add Bundle fields appear. 
10. In the Add field, type 1. 
11. Select the Bundle check box. 

1 bundle (43 pcs) is the designated inventory count to re-order the product at. 
12. Press ENTER to close the Add Bundle fields. 
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VIII. Creating a Purchase Order 
1. In the TJ-YardMate™ window, click the Inventory tab. 
2. Click Track Product On Order. 

The Product On Order dialog box opens.  
Note:  This dialog box is used to enter purchase order amounts, track the order, and update the 
inventory when the order is received.  
These amounts are included in the On Order totals in the Inventory tab.   
The Product Order Info group box is used to create and remove new Purchase Orders. Purchase 
Order entry affects only the Inventory tab information. 

3. Click Add. 
The Purchase Order text boxes become active. 

4. In the Purchase Order # text box, type 202. 
5. Press TAB to move the cursor to the Vendor list box. 
6. Click the list box arrow and select Weyerhaeuser. 
7. Press TAB to move the cursor to the Contact list box. 
8. Click the list box arrow and select TJ Rep. 
9. Press TAB to move the cursor to the Date Ordered list box. 

Note:  The PO Cutoff Date list box is used to limit the list of orders in the Product Order Info table. 
Type a date in the box or click the list box arrow and use the Calendar to select a date. 
Only orders expected after the entered date are listed in the table. 

10. Type the ordered date or 
Click the list box arrow and use the Calendar to select a date. 

11. Press TAB to move the cursor to the Date Expected list box. 
12. Type the expected date or 

Click the list box arrow and use the Calendar to select a date. 
13. Press TAB to move the cursor to the Product Order Details group box. 
14. In the Quantity text box, type 2  
15. Press TAB to move the cursor to the Bundle field.  
16. Press SPACE BAR and press TAB. 

This places a check in the Bundle check box. 
The cursor moves to the Length text box. 

17. In the Length text box, type 36. 
18. Press TAB to move the cursor to the Product # text box.  
19. Press TAB again. 

The cursor is now on the  button. 
20. Click  or 

Press ENTER. 
The Product dialog box opens. 

21. Select the Only Show Products with Inventory check box to limit the visible list. 
22. In the Product Groups table, click TJI®/ Pro™ Joists. 
23. In the Product table, double-click the 11 7/8” TJI 110 joist. 

The Product dialog box closes and the selected product is shown in the Product field. 
24. In the Product Order Details group box, click Add. 

This item is added to the Purchase Order. 
25. In the Purchase Order Info group box, click Save. 

This is located in the top, right corner of the dialog box. 
26. Click OK to save the information.  

The Inventory tab returns. 
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IX. Receiving an order 

1. In the TJ-YardMate™ window, click the Inventory tab. 
2. In the Product Groups table, click TJI®/ Pro™ Joists. 
3. In the Inventories table, click the 11 7/8” TJI 110 joist.  

Note that the On Order field now reflects the 86 pieces recently ordered. 
4. Click Track Product On Order. 

The Product On Order dialog box opens. 
5. In the Purchase Order Info group box, select Purchase Order # 202. 

The order was delivered but only 1 bundle of the 2 bundles (86 pieces) were received. 
6. In the Receive Order group box, click the Partial Order radio button.  

The cursor is in the Received field of the Product Order Details table. 
7. Type 1 to reflect what has been received. 
8. Click Receive Order. 

A warning message appears. 
9. Click Yes. 

A request message appears to create a new Purchase Order # for the remaining items.  
10. Click Yes to create the new order.  
11. In the Purchase Order # text box type 202B (as a back order) 

All other previous information is retained.  
12. Click Save. 

The new purchase order is added to the Product Order Info table. 
13. Click OK to close the Product On Order dialog box.  

The Inventory tab returns.  
The received quantity is updated in the In Stock column and the outstanding product is listed 
in the On Order column. 

 
X. Building Your Customer List 

1. In the TJ-YardMate™ window, click the Orders tab. 
2. In the Customers group box, click Add.  

The cursor is in the Customer text box on the Shipping Info tab. 
3. Type XYZ Builder. 
4. Click Save. 
5. In the Locations group box, click Add. 

The cursor is in the Location text box on the Shipping Info tab. 
6. Type Boise in the Location text box 
7. Click Save. 

Additional contact information can be entered but is not required. 
Note:  In the future, if you do not want to use TJ-YardMate for tracking orders, create a Default Customer 
and Default Location when creating cut optimization orders.  
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XI. Entering an Order 

1. In the TJ-YardMate™ window, click the Orders tab. 
2. In the Customers scroll box, locate and select XYZ Builder. 

Note: The date in the Order History Cutoff Date text box is used to limit the list of orders in the Orders 
table to orders that are expected after the entered date. 
Type a date or click the list box arrow to use the Calendar to select a date. 

3. In the Orders group box, click Add. 
The cursor is in the Order # text box in the Shipping Address group box. 

4. Type 1. 
Note:  An Order # is required to save the order.  
Select the Autonumber check box to use the TJ-YardMate™ order numbering when entering real 
orders.  

5. Click the Ship Date list box arrow. 
The Calendar opens. 

6. Select a date.  
Use the arrows at the top of the Calendar to move to different months. 

7. In the Ship To text box, type Pine Woods Mall and: 
Address:  999 Pine St.     City:  Anytown     State:  WA    Zip:  88888 
Phone:  (123)456-7890. 

8. In the Orders group box, click Save. 
The new order is saved in the Orders table.  

9. Click the Order Details tab. 
10. In the Quantity text box, type 3. 
11. Press TAB.  
12. In the Length text box, type 35. 
13. Press TAB.  
14. In the Product # text box type 1188110. 

The associated product description is shown in the Product box.  
15. Click Add Item to include the information in the Order table. 
16. Click Save in the Orders group box. 
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XII. Importing a TJ-Xpert® Job File for an order 

This section describes how to import products directly from the TJ-Xpert® job file to 
build your order list.     
1. In the TJ-YardMate™ window, click the Orders tab. 
2. In the Customers scroll box, locate and select XYZ Builder. 

Note: The date in the Order History Cutoff Date text box is used to limit the list of orders in the Orders 
table to orders that are expected after the entered date. 
Type a date or click the list box arrow to use the Calendar to select a date. 

3. In the Orders group box, click Add. 
4. Type 2. 

The cursor is in the Order # text box in the Shipping Address group box. 
5. Repeat Section XI, Steps 5 to 8. 
6. Click the Order Details tab. 
7. In the TJ-Xpert Imported Jobs group box, click Import TJ-Xpert Job. 

The Import TJ-Xpert Job dialog box opens. 
8. Use the Directories and Job scroll boxes to locate the Tutorial.job file. 

This is in the C:\Program Files\Trus Joist\TJ-YardMate\Jobs folder. 
9. In the Levels box, select the Main level check box. 
10. In the Levels box, clear the Roof level check box. 
11. Click Change Selected Products. 

The Select Imported Products dialog box opens.  
Use the dialog box to specify the products to be imported. 

12. Verify that all options are selected in the Product Type box. 
13. In the Application scroll box, verify these options are selected: 

Joists(J,Cf)  Rectangular Products(M) 
Headers(Hd) Closure(Rm, Cc, Pc) 
Blocking(Bk, Eb).  
Clear all other option check boxes. 

14. Click Save As Defaults to retain these selections when importing future TJ-Xpert® jobs. 
15. Click OK. 

The Select Imported Products dialog box closes. 
The Import TJ-Xpert Job dialog box returns. 

16. Verify the Import Blocking As: selection is Total Length. 
17. Click OK to apply the information. 

The selected applications are imported. 
18. Click OK. 

The information is imported into the Order Details table. 
19. In the Description text box, type Tutorial. 

This overwrites the text imported from the file. 
20. In the Orders group box, click Save. 
21. Go to Section XIII to cut optimize the order. 
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XIII. Cut Optimizing the Order 
1. Click Optimize Order. 

The Order Details information is transferred to the Cut Optimization tab. 
The Selected Orders table lists the orders included in the cut analysis.  

2. In the Selected Orders group box, click Add. 
The Select Order dialog box opens. 

3. Select Order 1 and click OK. 
The Cut Optimization tab returns. 
Order 1 is added to the Selected Orders table and the order details are added to the Order 
List table. 

Note:  If more than one order is included in the cut analysis, the program assigns a Cut Order I.D. 
number in the Identifier column. 
For example: (O-1) for the first order, (O-2) for the second order.  
For more than one imported TJ-Xpert® job level, the program assigns Level I. D. numbers:  (O-1)(JL-1); 
(O-1)(JL-2); (O-1)(JL-3). 

4. In the Cut List Notes text box, type Call Contact before shipping. 
This text appears on the Cut List report.  

5. Click Copy To Shipping Ticket. 
This information is copied into the Shipping Ticket Notes text box. 
It also appears on the Shipping Ticket report. 

6. Click Cut Optimize.  
The cut analysis is started. 
The cut results are shown on the Remaining Cuts and/or Completed Cuts tab. 
The Remaining Cuts tab lists the products that were not optimized during cut analysis.  
Use this tab to manually type a cut pattern for these products to best utilize your available 
inventory. 

7. Go to Section XIV to cut a pattern manually. 
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XIV. Creating a Cut Pattern Manually 
1. Click the Remaining Cuts tab. 

The Current Product group box lists product not cut during cut analysis.  
2. In the Product list box, click the 11 7/8” TJI 110 joist.  

The Remaining Cuts table has a Quantity of 2 pieces of product 22’ in Length. 
The Remaining Blocking table has an Identifier (O-1) with a 3’ 5 ¾” Length. 

3. In the Remaining Cuts table, double-click either the Quantity or Length fields for the two 
22’ pieces of  11 7/8” TJI 110 joist.  
The Cut 1 field shows the 22’ length.  
In the Length field, the program selects from the Available Inventory list a  36’ Length to 
be used for this pattern, giving an OffCut of 14’.  
The Repeat Cut Pattern spin box shows a 2 to indicate this cut pattern will be repeated two 
times.  

For the purposes of this tutorial, assume that this is not an optimal cut, and that we would rather make 
two 22’ cuts on the same pattern. 

4. Click the Repeat Cut Pattern  spin box once. 
The box shows 1.  
One of the 22’ lengths returns to the Remaining Cuts table. 

5. Double-click a 22’ in the Length field.  
One 22’ length is now shown in the Cut 2 field. 
One 22’ length remains in the Remaining Cuts table. 

6. In the Remaining Blocking table, double-click the 3’ 5 ¾”. 
This creates Cut 3.  

Note: A 48’ Length from Available Inventory Length was used. 
There is a 6 ¼” Offcut. 
By default, this offcut is considered “waste in the yard”.   

7. Select the Ship Waste check box. 
The 6 ¼” Offcut is now included with the shipped product. 

8. Click Add to Completed Cuts. 
This pattern is sent to the Completed Cuts tab. 

9. In the Products list box, click 1 ¾” X 11 7/8” 1.7E TimberStrand LSL.  
10. In the Remaining Cuts table, double-click 12’ in the Length field. 

This creates Cut 1. 
11. In the Remaining Cuts table, double-click 10’ in the Length field. 

This creates Cut 2. 
Note: A 37’ Length from Available Inventory was used.  
There is a 15’ OffCut.  

12. Click Add to Completed Cuts.  
There are no more cuts to be made. 

13. Click the Completed Cuts tab. 
The tab shows the cut patterns for this Cut Order.  

Note:  Waste is shown in the lower left corner both as lineal feet and a percentage of the material used.  

March 2005 TJ-YardMate™ 2.10 54 



 

14. Review the Completed Cut Patterns to identify the changes that were made: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16 Completed Cut Pattern example results  

 
 
 
 
  
 
If you can identify the specific product cuts that are incorrect: 
  

15.  Verify that your Completed Cut Patterns information is the same as the 
graphic’s information above. 
If the information is the same, go to Step 16.  
If your information is not the same the image above, follow the steps 
below: 

6 ¼” (S) indicates 
that this amount 
was wasted and 
shipped with the 
pattern. The Ship 
Waste check box 
was selected so 
this would 
happen.  

16’(R ) indicates 
that 16’ was 
returned to stock. 
This particular cut 
was made based on 
the Preferred 
Length default 
selection of 16’. 

1’(W) indicates that 
1’ was wasted and is 
cut off in the yard. 

a) Select the incorrect cut patterns and click Remove Cut.  
b) Click the Remaining Cuts tab. 
c)  In Section XIV, Creating a Cut Pattern Manually, repeat the steps for each 

product that was cut incorrectly.  
 

If you cannot identify the specific product cuts that are incorrect: 
 

a) Click the Orders tab. 
b) Click OK to the warning message. 
c) In the Orders table, click Order # 1.  
d) Click the Orders Details tab. 
e) Click Optimize Order. 
f) In the Select Orders group box, click Add.  

The Select Orders dialog box opens.  
g) Check each order listed in the dialog box. 
h) Click OK to include them in the Cut Order. 
i) Go to the Section XIII, Cut Optimizing the Order and begin at Step 2. 

 
16. Click Deduct From Inventory.  

The product used for this cut order is subtracted from the current inventory.  
A warning regarding permanent changes that are about to take place appears. 

17. Click Yes to acknowledge the message and deduct the product from inventory. 
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XV. Printing A Cut Report or Shipping Ticket 
1. On the Completed Cuts tab, click Print. 

The Print dialog box opens. 
2. Select the Cut List check box. 
3. Select the Include TJ-Xpert Plot Labels check box. 
4. In the Additional Report Notes text box, type any information to include on the report. 

The Shipping Ticket information group box is available to print after you have deducted the 
Cut Order from inventory.  
A separate shipping ticket is printed for each Product Order included in the cut analysis.  

5. Select the Shipping Ticket check box. 
6. Click either the Cut In Yard or Cut on Job-site radio button. 
7. In the Style group box, click Horizontal. 

This is the layout orientation of the report.  
8. Click Print Preview to view the report on screen or  

Click Print to send the report to the default printer.  
9. Click Close to exit the Print dialog box. 
 

Note:  This concludes the TJ-YardMate Tutorial.  
Before working in TJ-YardMate, you must return to the Program database using the instructions in 
Section XVI. This is done to ensure the validity of your company’s inventory and historical information. 
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XVI. Returning to TJ-YardMate™’s Program Database 
1. On the Tools menu, click Defaults. 

The Defaults dialog box opens.  
2. Click the Program Defaults tab. 

In the Program Paths group box, the Database: field shows the database location the TJ-
YardMate™ program is currently using: 
C:\Program Files\Trus Joist\TJ-YardMate\Tutorial\. 

3. Network users – follow these procedures 
a) Highlight all the text in the Database: text box. 
b) Go to Section II, Step 3b to find the original database location. 
c) Click Browse. 
d) Locate the database file. 
e) Double-click the file. 

The Database: text box now shows: 
 C:\Program Files\Trus Joist\TJ-YardMate\ Program\. 

Stand-alone Users – follow these procedures 
a) Click in the Database: text box and highlight Tutorial\.   
b) Type Program\.  

If you used the installation default location, the Database: text box now shows 
C:\Program Files\Trus Joist\TJ-YardMate\Program\. 

4. Click Apply. 
The work done in TJ-YardMate™ is now using the Program database.  
A Restart message appears requesting you to restart the program so changes are applied. 

5. Click OK to acknowledge the message. 
6. Click OK to close the Defaults dialog box. 
7. On the File menu, click Exit.  

The TJ-YardMate™ program closes. 
8. Restart TJ-YardMate™ and click OK on the login screen. 

Note:  Use Section III of the tutorial to set up TJ-YardMate™ for the way your company does business 
and to get your users program access in User Security. 
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Suggestion and Request Form 
User’s Name:____________________________________        Date:_________________ 
Company Name:  _________________________________        
Street Address: _______________________________________________  
  _______________________________________________ 
 Phone:________________________      Fax:________________________ 
TJ Automation Representative:______________________________________    
Location:________________________________________________________ 
Comments:_____________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________ 

Thank you for taking the time to share your ideas. 
Fax or Mail to: Engineering Automation  

Trus Joist™ 
7800 East Orchard Road, Suite 200 
Greenwood Village, CO  80111 
Fax:   303/770-1472 

= = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = =  
(For Trus Joist Internal Use Only) 

Date Received:______________    
ActionTaken:______________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________ 

Signed:____________________________ Date:______________________________ 
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